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How do we interact and engage?

ICANN Meetings
Open to all
No registration fee
Three times a year
Rotating location in 5 regions

Remote Participation available




Why Remote Participation?

Cost effective
Enables wider inclusion

ICANN commitment
Board and PPC
Staff




Equalize Participation

< Remote and Face-to-face Participants

Maximize access

X oA Low vs High Bandwidth




Low Bandwidth?

What do you need?

Minimum 128 kb/sec and a Web Browser

What do you get?

* Live and recorded audio streams in multiple languages

* Presentations for download

* Live scribes

* Transcripts




High Bandwidth?

What do you need?

Minimum 512 kb/sec, a Web Browser and Flash Player

What do you get?

* Adobe Connect (AC) view

Video + Audio + Chat

Also available for some mobile devices

Live and recorded Audio Streams

Chat Room and Real-time Presentations

Live scribing where available



How?

http:/ /toronto45.icann.org/full-schedule

[vome | Reger | T | Voma | Somaie | Soonor | pracacaive

ome

‘ull Schedule View

CANN 45 | Toronto | 14 - 18 October 2012 KEY

chedule subject to change. General Session

Daily Overview » Topic Sessions & Facilitative Documents Schedule Newcomers' Track
ocuments Posted in Preparation of Toronto Meeting Networking Event
[C] = Closed Session

ichedule Views
Sorted Schedule View » Remote Schedule View » Remote Participation Overview » Venue Map

RIDAY, 12 OCTOBER

ROOMS: Fairmont Royal York Hotel Harbour C Marine Metro Centre  Metro East  Pier 2&3  Pier 485 ‘2:::’" 1’ ?;::yn; Regatta

730 - 0800 - - - - - - - - - -
1900 - 0930 - - - .
1930 - 1000 - - - -
000 - 1030 - - - -
030 - 1100 BREAK BREAK BREAK BREAK BREA BREAK
100 - 1430 ) . . Generation .
Rules (LGR)
130 - 1200 - - - for the Root -
200 - 1230 NCUC Policy Conference: ICANN & Internet - . - Zone in Law -
230 - 1300 Governance: Security & Freedom in a Respect of Enforcement
5T SRR LUNCH LUNCH LUNCH LUNCH IDNA  Workshop [C] LUNCH
z BREAK BREAK BREAK BREAK Labels BREAK

330 - 1400 hosted by ICANN's Non-Commercial Users

400 - 1430 Constituency (NCUC) ) ) )

Team (0900 - 1700)
Workshop

430 - 1500 (08:30 - 19:30) - - -

(0800 -
500 - 1530 - . . ,



Check Session Details

Public Forum

Date: Thu, 18 October 2012 - 14:00 - 18:30 =~ == Add to Calendar

Room: Metro Centre
Session Leader: Filiz Yilmaz | Senior Director, Participation and Engagement

Transcript to be provided
Remote Participation - Low Bandwidth

Audiocast:
English
Espafiol
Frangais
Pycckuit
B3z

Remote Participation - High Bandwidth

Audiocast:
Ayl
English
Espafiol
Frangais
Pycckuit

$3Z

Virtual Meeting Room
http://icann.adobeconnect.com/yyz45-metroeastcen




Join a meeting on Adobe Connect

ADOBE CONNECT"

ICANN Meeting 45 - Metro East Center

(s) Enter as a Guest

Name | iliz Yilmaz

Enter Room

() Enter with your login and password




Adobe Connect Interface

Al I I n 0 n e |MPORTANT ISSUE SO | ENCOURAGE N =8 Participate in ICANN: Ten Open Comment Fora

EVERYBODY |N THIS ROOM ‘NHO HAS rademark & Community Protection Malicious Conduct
BEEN VERY ACTIVE IN THIS, - . - .2 _

THERE'S NOT BEEN A LOT OF
DISCUSSION ABOUT THIS ISSUE, AND
C h at ‘B NOW IS THE TIME TO GET INVOLVED
WITH IT AND MAKE SOME
. CONTRIBUTION TOIT.
Vi d eo SO THAT'S SORT OF A SEGUE

Presentations

331333333




Forms (for Public Forum)

NNNNN

Submit

guestions or pe——
comments A

Linked from = commen

session details
page




Remote Participant Checklist

Join via low or high bandwidth
services

Interact with the others

Chat room = virtual meeting

Be aware of rules of behaviour

http://www.icann.org/en/news/in-focus/
accountability/expected-standards




Problems/Questions/Feedback

See Remote Participation Services and

Concepts:
http://meetings.icann.org/remote-participation

Problems: Report in the chat room!

Questions/Comments:

—— Write us at participate@icann.org

Online survey after attending
sessions:

https://www.surveymonkey.com/s/
icann45RP




Post Meeting

Presentations
Audio files
Transcripts

All archived and
Accessible on meeting site




How do we interact and engage?

In between meetings, all the time:

Community Mailing lists

Groups have their own mls

Public Comment Periods

http://www.icann.org/en/news/public-comment




Public comments

DRAFT - ICANN Language Services Policy and

Procedures

Comment Open:
Comment Close:
Close Time (UTC):
Reply Open:
Reply Close:
Close Time (UTC):
Brief Overview
Originating

Organization:

Categories/Tags:

Purpose (Brief):

Current Status:

Next Steps:

Comment/Reply Periods

Frangais {& ol
18 May 2012 Important Information Links
2 July 2012
2358 UTC Public Comment Announcement
3 July 2012 To Submit Your Comments (Forum)
1 August 2012 omments Submitted
23:58 UTC Report of Public Comments

ICANN Communications Department

Policy Processes, Transparency/Accountability, Reviews/improvements; Participation;
EventsiConferences

Community members are asked to provide feedback on the proposed document. ICANN Language

Services provices support for transiation, simultaneous interpretation, teleconference interpretation,

transcription (of recorded sassions) ane RTT (real-time-transcription, also known as scribing).

Draft ICAN

{ Language Senvices Policy and Procecures open for public comment.

Comments will be accepted in this forum and in continued interaction with the community and staff,

recommendation




How do we interact and engage?

Community wikis...




Agenda

What is a Wiki?

Basic Wiki Structure
Wiki Training Guides
Log in

Tool Options

How to Add a Comment
Questions and Answers




What is a Wiki?

A wiki is a tool to support
collaboration of information at an
individual, team, corporate or
community level. Wikis allow edition
of information by all contributors.

Simply put, a wiki is a website that
allows you to edit content in an easy
and collaborative way




Basic Wiki Structure

* This wiki installation is set-up to allow global
viewing and editing of content by ICANN’s
community members.

* The Confluence Wiki is structured by
workspaces. Workspaces contain pages.
Pages contain information (text and images)
and can have attachments (images, office docs,
pdfs, etc.).

 Pages organized in a workspace are in a
hierarchical structure. When a page is added to
another page, the resulting page is known as a
child page. The initial page is the parent page.




Wiki Training Guides

Available in the following 6 languages:

1. English 2. French
3. Arabic 4. Chinese

5. Spanish 6. Russian

https://community.icann.org/
display/help/Wiki+Training
+Guides




When You Click Log In....

- Confluence ¥ Ieass  lmk

In the Username and Password text boxes, enter the Username/Password sent to
you by a Confluence Wiki Administrator. If you require this information, please
contact community-help@icann.org.

e pper T PP




Your Community Wiki...
& SO &

ICANN
L= Board Res Projects w At-Large v Cross Comm v GNSO w AoC v New gTLD Help
Dashboard Q Browse
@ Spaces Category ﬁ Favourite Pages
. Board Res Displaying pages recently added to your favourites list.
© Transparency and Accountability Projects At-Large Improvements Taskforce Meeting 25-06-2012 Prague (At-Large Improvements Workspace) *
- Projects At-Large Improvements Implementation Taskforce WG 04-06-2012 (At-Large Improvements Workspace) *
© ICANN.org Redesign At-Large Improvements Implementation Taskforce WG 21-05-2012 (At-Large Improvements Workspace) *
&) ICANN Stakeholder Satisfaction Survey-2011 At-Large Metrics Working Group Meeting 1 -May-2012 (At-Large Improvements Workspace) *
@ New gTLD Advertising Campaign At-Large Rules of Procedure 16-04-2012 (At-Large Improvements Workspace) *
© Public Comment Focus Group At-Large Improvements Taskforce Meeting with the SIC 15-03-2012 (At-Large Improvements Workspace) *
@) RAA Amendment Negotiations ) ) ) ) o
Copy of Latin American and Caribbean Islands Regional At-Large Organization (LACRALO) (Latin American and Caribbean *
- Atlarge Islands Regional At-Large Organization (LACRALO))
ALAC At-Large Improvements Implementation Taskforce WG 30-04-2012 (At-Large Improvements Workspace) *
© AAC At-Large Improvements Implementation Taskforce Workshop 13-03-2012 (At-Large Improvements Workspace) *
€ ALAC Executive Committee At-Large Improvements Project Taskforce 27-02-2012 (At-Large Improvements Workspace) *

&) ALAC Read-Only Document Store

@ At-Large Policy Development
&5 Tag cloud
— At-Large Workspaces

@ At-Large Accountability and Transparency Review Team Workspace 1998 1999 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011
@ At-Large Board Candidate Evaluation Committee administration agreements alac atlarge POAard budget ccnso  cctlds  centralpage  dag



Tool Options...

On the top right hand side of the page, you will see a menu with the
following items: Edit, Add, Tools, Browse and your Login Name.

dRes
arge v

edl
n 6 Cross Community Work Group
d Resolution response drafting space

3udget Proposal Master Document

D Applicant Support Working Group
ind Budget Sub-Committees WG

ind Budget Sub-Committees WG Resources
ind Budget Sub-Committees WG Members
ind Budget Sub-Committees WG Monthly

ocess WG Resources
ocess WG Documents
ocess WG Members

ocess Meetings and Events
ocess WG Monthly Reports

3 Transcription of Discussion on Vertical
aining Guides

2 Wiki Training Guides

3-12-2011 Action Iltems

Cross Comm GNSO « CccNSO GAC AoC New gTLD « Help « Sandbox v

ALAC 22.02.11 - Monthly Teleconference

& 12 Added by Marilyn Vernon, last edited by Alac Temp on Mar 21, 2011

ALAC Monthly Teleconference

Meeting Number: AL.ALAC/CC.0211/1

# Edit

Tools Options

Date: Tuesday, 22 February 2011

Time: 1400 - 1530 UTC

(For the time in various timezones click here)

Adobe Connect Meeting Room: http://icann.adobeconnect.com/alacjanjun2011/

Interpretation Available: Yes (EN, FR, ES - Simultaneous)
How can | participate in this meeting?
Comment est-ce qu'on peut participer a la téléconférence?

¢Como se puede participar en la teleconferencia?

Who is on the dial-out list for this call?

ALAC Participants: Cheryl Langdon-Orr, Olivier Crepin-Leblond, Gareth Shearman, Sylvia Herlein Leite, Tijani Ben Jemaa, Jean-Jacques Subrenat, Marc Rotenberg, Sandra Hoferichter, Evan Leibovitch, Edi

Liai IG bastien B llet, Alan Greenberg, Ron Sherwood, Hong Xue, Dev Anand Teelucksingh

Apologies: Dave Kissoondoyal, Sergio Salinas Porto, James Seng, Fatimata Seye Sylla (non ALAC)
Absent: Mohamed El Bashir, Carlton Samuels

K4 Share < Add



How to Add a Comment...

CrossComm v GNSO v NSO v GACv AoC v NewgTlLD v Help v  Sandbox v

C # Edit K4 Share £ Tools Q Browse &

[ Page
(@] Blog Post 4

At-Large Advisory Committee (ALAC)

&5 Added by Samantha.Oltman, last edited by Heidi Ulirich on Feb 27, 2012 (view change) %] Bookmark

& Attachment

Add Comment

What is At-Large?

"At-Large" is the name for the community of individual Internet users who participate in the policy development work of ICANN. C
more than 139 groups representing the views of individual Internet users are active throughout the world. You can learn more abc

B I C ANN community and its activities on this website, as well as how to join and participate in building the future of the worldwide Domain
ndm:n; Cross Community Work Group AT-LARGE System (DNS) and other unique identifiers that every single user of the Internet relies on every time they go online.

Board Resolution response drafting space

Y12 Budget Proposal Master Document At-Large Outreach Workspace

w gTLD Applicant Support Working Group

ince and Budget Sub-Committees WG
s

ince and Budget Sub-Committees WG Resources

ince and Budget Sub-Commitiees WG Members Latest ICANN News... At-Large Announcements...

ince and Budget Sub-Committees WG Monthly

Public Comment: Proposal to Protect International Red Cross and International Olympic Committee (161) Internet Society Armenia Chapter certified as At-Large Structure (ALS)
3T Process WG Resources Names at the Top Level in New gTLDs (157) Internet Society Cameroon Chapter certified as At-Large Structure (ALS)
RT Process WG Documents Call for Videos: New gTLD Applicant Stories and Learnings Sought ALAC Breaks Previous Year's Record with 40 Policy Statements Submitted in 2011
e S ICANN and Registrar Negotiation Team Post S y of RAA Negotiati ISOC-CR Costa Rica Society for Internet Development certified as At-Large Structure (ALS)
RT Process Meetings and Events REMINDER NOTICE: 29 March is Last Day to Register as New gTLD Applicant TaC-Together Against Cybercrime certified as At-Large Structure (ALS)
RT Process WG Monthly Reports Draft Advice Letter on C Trust, C Choice, and Competition
r 2009 Transcription of Discussion on Vertical
}i?Tmi“ing e Older At-Large Announcements

Large Wiki Training Guides

N 1.12.2N11 Artinn fame




Useful Tabs...
(Bookmarks and Watches)

Bookmarks

Go to Add menu item and select Bookmark, a link to this page
will be added to the Labels section of your profile.

(This allows you to access the page quickly at a later time.)

Watches (pages or spaces that you chose to follow)

Select Watch in the Tools menu item
(You will be notified of changes to these pages via email.)




Additional Documentation...

More information on working with User Profiles:

http://confluence.atlassian.com/display/CONF34/
Confluence+User%27s+Guide#ConfluenceUser
%27sGuide-WorkingwithUserProfiles

More information and documentation exists for
Confluence Wiki:
http://confluence.atlassian.com/display/DOC/
Confluence+Documentation+Home

A User’s Guide for Confluence:
http://confluence.atlassian.com/display/CONF34/
Confluence+User%27s+Guide.




How can | get involved?

Attend an ICANN meeting

In person or virtually
Next in Beijing, April 2013
Specific sessions for Newcomers

Apply for Fellowship
http://www.icann.org/en/fellowships/




How can | get involved?

Subscribe to News and Policy Updates

http://www.icann.org/en/newsletter/

Participate in Public Comments
http://icann.org/en/public-comment/

Follow Community Wikis

https://community.icann.org/dashboard.action

Apply for a Leadership Position

http://nomcom.icann.org




Thank You

TORONTO




One World

Questions

One Internet




